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Its no secret that the internet is has become
the largest, most effective method of in-
stant communication.  People are exchang-
ing messages along with drawings and other
files at lightning speed.  Decisions are be-
ing made in hours that used to take days with
conventional information exchange such as
the shipping of drawings and documents.

Just as the world has changed to
accomodate these improvements, Carlson
Software has embraced the technology in
an effort to provide you (our valued cus-
tomer) with better service.  We would like
to take a moment to elaborate on some
present and future services that you should
be taking advantage of.

Website:  Our website can be visited at
http://www.carlsonsw.com.  An example of
the home page is shown at right.  From the
home page you can navigate to the various
sections.  Some of these include:

� Products: New and even existing users
should check out all the products
available to enhance their capabilities.

� Services: Check out other services we
provide, such as training and GIS
consultation.

� Support: Existing users should check
out the procedures, walk-thru�s with
graphics and step-by-step instructions.

� Whats New: Watch this area for
information on newly released products,
as well as new versions of existing ones.

� File/Patch Area: We post the latest
versions of the products you use in this
area, allowing you to �update yourself�
from the website.  Be sure you have
your serial number handy.

� Search: This may be the single most
important link at our site.  It lets you
enter a keyword and find all documents
containing that word or phrase.

We intend to constantly add to the site, so
visit often.

Email Newsletters:  The time and effort
associated with printed newsletters such as
these make them difficult to produce in a
timely manner.  To allow us to communi-
cate with our user base more efficiently we
will be moving to the popular e-news for-
mat.  This will allow us to release informa-
tion much more frequently.  Our goal is one
e-news per month.  This also allows mul-
tiple users at any site to receive the news-
letter directly, not just ending up in the mail
stack.

However in order for you to receive the
email newsletter we need your email ad-
dress.  Please take a moment to send an
email to webmaster@carlsonsw.com with
the email addresses of all those who wish
to receive it.  Please include the company
name and ID number from the back of this
newsletter if available so that we can asso-
ciate you with your company.

Tax Mapping Website: Visit our Mason
County Tax Map at hq.carlsonsw.com.  This
is tax mapping on the web, allowing you to
do all your property research from the of-
fice.  We can help your city or county de-

velop the same capability for the one time
cost of $5/parcel.

Discussion Groups:  This area of our web
is currently underutilized, and we firmly
suspect its largely due to the fact that users
don�t know it exists.  Its a chat area of sorts,
a place where you can ask questions, post
comments and ideas, and exchange views
and knowledge with your fellow Carlson
users.  Of course the Carlson staff is avail-
able to answer posted questions, but there
is a special interaction that can take place
between users.  The groups are also broken
down into various areas depending on the
modules used, to help narrow the focus of
the discussion.  Choose the �Newsgroups�
link from the Carlson website to navigate
to our newsgroups.  See you there!
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A powerful centerline entry routine has
been �quietly� added to SurvCADD, and
many users have yet to discover it.  In fact,
the routine has only been available in its full
working form since July, 1999.  It is found
under the Design pulldown menu in the Sec-
tion-Profile module of SurvCADD 2000,
as well as under the Roads pulldown menu
in Carlson Roads 99.  It is a dialog-based,
non-graphic alternative to Design
Centerline, and has the advantage of accept-
ing whatever information you have on your
centerlines�coordinates, stationing,
length of tangents and arcs, etc.  It is ideal
for entering centerlines straight from high-
way design plans.  Let�s review a typical
example:

IntrIntrIntrIntrIntroducing Input-oducing Input-oducing Input-oducing Input-oducing Input-
Edit CenterlineEdit CenterlineEdit CenterlineEdit CenterlineEdit Centerline

This centerline, for a highway interchange
ramp, involves a starting tangent, then a spi-
ral curve that goes abruptly into a simple
curve, then a final tangent.  The sequence
of entry is (1) Starting Dialog, (2) Line
Segment, (3) Spiral Segment, (4) Curve
Segment and (5) Final Tangent Segment.
Here are all 5 dialogs, with entries high-
lighted.  Note that entry of point numbers
(to calculate points) is optional:

Starting Dialog:  You start by entering a
starting Northing and Easting and starting
Station, and the Start Point# is optional.
Then the concept is that you click Add to
add each subsequent element.  The three
types of elements are Line (tangent sec-

tion), Curve and Spiral.  Spirals can be �un-
symmetrical� as in spiral in only, so all nec-
essary flexibility is in the 3 elements.  Our
first element is the tangent section.

Line (Tangent) Segment:  We want to en-
ter the tangent segment length up to the TS
(tangent to spiral).  This length is not pro-

vided explicitly
(see graphic), but
can be entered in
the form of sub-
traction as shown.
Pressing Enter af-
ter the Length en-
try will compute
the actual Length
as 233.71.  Note
also that the End

Point# is optional.  Each dialog for Line,
Curve or Spiral elements always shows the
last known station point, in this case 1200.
When OK is clicked, the routine will add
the Line Element as the first in the list of
completed centerline elements.  Next up is
the Spiral.  Click Add.

Spiral Segment:  Though the dialog is com-
plex (for total flexibility), enter the four
items shown, which can be done in the
clockwise order shown:

The key on a typical spiral curve is to enter
four things:  the radius of the simple curve,
the spiral in and spiral out lengths, the tan-

gent bearing out and the PI station.  Every-
thing else will calculate when you press En-
ter for the PI station.

1

4
3

2

Curve Segment: Add your next element and
select curve.  The following dialog appears.
The key is to enter the Radius Length (255),
the Arc Length (150) and the Curve Direc-
tion.  Everything else will calculate.

Final Line Segment:  All you need to en-
ter in the final dialog for the line (tangent)
segment is its length.  All other items will
calculate when you press Enter.

This completes the Centerline, which can
be drawn by the command Centerline File
to Polyline.  The completed Centerline will
appear as shown below in a dialog, and each
element can be Edited.
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What is a Raw File and Why Do I Need It?
A raw file contains the angles and distances
measured by a total station, as well as ref-
erences to the set up point number and fore-
sight point number.  A raw file also contains
special records of information such as in-
strument height and rod height, backsight
references, note fields, and point entry
records.  A raw file can be created four
ways:  (1) by downloading data collectors
containing raw files, (2) by importing or
converting raw files from other sources, (3)
by direct entry in the Raw File Editor shown
below, and (4) by entering field notes (eg.
traverses and sideshots) within the Carlson
program, with the �Raw File On/Off� op-
tion clicked on.  Raw files are needed as a
record of field work, as a spreadsheet of
information that can be edited and as a ba-
sis for computing and re-computing coor-
dinates by different methods of adjustment.
All Carlson raw files have the extension
�.RW5� and are essentially TDS format.
Coordinate values for all foresights and en-
tered points are calculated by the com-
mands found under the �Process� pulldown
menu.  The most basic form of calculation
is �No Adjust�.  All calculated points are
stored in the coordinate file (CRD file) that
is currently active.  Only one coordinate
file can be active at a time, and the active or
working file can be selected by the com-
mand �Set Coordinate File�.

An Independent, Ready-to-Process Raw
File:  It is important to look at raw files
and get a sense of what will process and what
won�t, what requires a coordinate file and
what will process without a single pre-
stored coordinate point.  Start with the file
shown in the graphic below:

This file is �self-sufficient�.  The active
coordinate file could be newly created and
empty of coordinates.  If  the raw file is
processed, for example, by No Adjust, all
coordinates would be calculated.  Here�s

A Primer onA Primer onA Primer onA Primer onA Primer on
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why:  The occupied point 1 in record 9 is
pre-defined in record 7 as having coordi-
nates of 5000,5000,100.  Point 3 is given a
reference azimuth of 0 and becomes the
backsight for point 1 in record 11.  Fore-
sights to points 2, 101, 102 and 103 would
be from a setup on occupied point 1,
backsighting point 3.  However, this is not
a perfect raw file.  A rod height is missing.
It would be inconsistent to have an instru-
ment height of 5.03 and no rod height.  If
there were no instrument height record, one
could assume that the rod was set to the
height of the instrument, and the differences
canceled out.  That is a common field pro-
cedure.  But it is red flag to have one and
not the other.  The DS records shown above
refer only to notes and are not processed
in any way.  Note also that distinct records
(HI, PT, SS) have their own special �header�
lines above them.  The header line for HI is
InstHt and RodHt, for example.  If you click
the mouse on a particular header line and
press the Delete key on your computer, it
will not erase the line.  However, if you de-
lete the HI record, the header line has no
further purpose and it can then be deleted.
It will disappear, in any case, if the raw file
is saved and re-loaded after deleting the HI
line.  The program recognizes automatically
header lines to delete.

A Raw File that Processes only if Starter
Coordinates Exist:  Most raw files do not
have field-entered or user-entered coordi-
nates.  They take off from a setup point and
backsight point that must exist in the �ac-
tive� coordinate file, or no calculation will
take place.  Consider the raw file in the dia-
log above.

This is a very simple raw file where no
backsight is necessary, because the first
traverse record is an azimuth traverse from

point 8.  With azimuth, there
is no need for a backsight.
Note that there is no zenith
angle column.  This is be-
cause it has been turned off
within the Display options.
Look closely at the raw file
and you will see that this is a
4-sided traverse, a rectangle
of 150x100 (approxi-

mately), closing back to point 8.  There are
also 2 sideshots along the way.  The traverse
can be �processed� by No Adjust or by Com-
pass, Transit, Crandall or Least Squares.  But
nothing will happen if there is no coordi-
nate for point 8 to start from.  If the coor-
dinate file is empty, this file will not pro-
cess at all.  Point 8 could be added to the
file using the CRD pulldown menu.

Processing (Calculating) a Raw File:  As-
suming point 8 exists in the above file, se-
lecting Process, No Adjust, defaults to
closing back to the starting point, and leads
to the report shown below:

By contrast, selecting one of the closure
adjustments (such as Compass rule) re-
quires the user to specify which point is the

reference closing point.  Thus, the routine
applies equally well to �open� (point-to-
point) as well as �closed� (looped)
traverses.  In our case, the traverse is closed,
so the dialog for the closing point is filled
out as shown here:

The �Reference Closing Point� is the point
that the last point in the traverse is trying to
match.  So in this case, the shot to 14 is
trying to match the starting point 8.  Point
8 becomes the reference closing point.

Plotting Out a Raw File:  Sometimes it is
beneficial to �see� the
traverse and sideshots
plotted out.  This is a
good way to detect
�busts� and bad shots.
The command to plot
out a color-coded
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traverse is found under Options, Draw
Traverse-Sideshot Lines.  This command
should be issued only after the raw file has
been adjusted by some method, and all
points calculated.  You must exit the Raw
Editor to see the plot.

Importing Raw Files:  Under the File
Pulldown within Edit Process Raw File is
the option to import raw files.  There are a
variety of import options, including read-
ing Leica GSI files in one of three formats:
(1) Wildsoft, (2) Liscad and (3) 10-20-30-
40.  Liscad format is the default.

Immediate plans are to include the LDD
FieldBook raw file format among the im-
port options.

Editing Raw Files:  Let�s pretend we have
a problem file so we can study how to edit
and add lines.  Please review the file below.
(Hint:  where�s the backsight for the first
angle right?).

The first thing to do would be to Add a
Backsight record.  If we assume that we

were setup on 1 and backsighting an azimuth
of 180 (due south), then we would locate
the cursor as shown above, select Backsight
under the Add pulldown menu, and fill out
the new line.

Hitting Add will lead to an
insert.  You do not need to,
and shouldn�t, use the In-
sert key on your keyboard.
To be even more thorough,
we could delete the first HI
record, because it is dupli-
cated and overwritten by
the HI record on line 6.  If

we position the cursor on line 2, we can hit
the Delete key.  Then we can position the
cursor on line 1 and delete the now useless
header line.  To change any entry in a raw
file, simply position the cursor over the
item and re-enter the values.  For traverses
and sideshots, pressing Enter will move for-

ward naturally from
horizontal angle to
slope distance to
zenith angle, etc.
The Tab key also
moves forward, and
Shift Tab moves
backward.  When an
entry �lights up
blue�, it can be sim-
ply re-entered by
typing a new entry.
If it is not lit up, you
can revise it by add-
ing individual char-
acters to the entry,
or by backspacing
out individual char-
acters.  An entire set
of field notes can be

entered from scratch using the raw editor
and making the proper selections under the
Add pulldown.  Once a traverse or sideshot
is entered, the program will remain in the
traverse or sideshot �mode� until altered.
Traverses and sideshots, once begun, do not
need backsights, since they assume that the
previously occupied point is the backsight,
by definition.  If this is not the case, you
must insert a special backsight record.

Advanced Raw Editor Usage:  This article
was designed to familiarize the novice with
the Carlson Raw Editor, found in both
SurvCADD and Carlson Survey.  None of
the above files, for example, were designed
to illustrate angle balance.  That and other
Raw Editor issues will be reserved for the
next newsletter!

CarCarCarCarCarlson Surlson Surlson Surlson Surlson Survvvvveeeeeyyyyy

Carlson Survey has proven to be one of the
most popular products of Carlson Software.
Priced at only $1295, it includes the
AutoCAD R14 OEM engine and covers the
full range of survey features from data col-
lection to Cogo to drafting and annotation.
It is the ideal upgrade product for users of
the DOS based Surveyor 1 program.  It also
offers a way for large engineering firms to
cost-effectively add work stations for sur-
vey work and field note downloading.
Carlson Survey works in the native
AutoCAD DWG format.  Users can upgrade
from Carlson Survey 98 to the current re-
lease for $245.

TTTTTips & Tips & Tips & Tips & Tips & Tricricricricrickkkkksssss

Carlson OEM products (Survey, Roads)
Customization: Many customers have
asked about the customization possibilities
with the Carlson OEM products (Carlson
Survey & Carlson Roads).  Currently, we
do not support customizing the menu or
toolbars.  If you attempt to customize the
toolbars it will result in a corrupt menu, and
the only way to correct this is to re-install.

Unhandled Exception - Fatal Error:  Ex-
perienced AutoCAD users may be familiar
with this message, but sometimes Carlson
Survey and Roads users are faced with this
also. Most of the time, this message means
that the current drawing has become cor-
rupt. This will be followed by a dialog ask-
ing you if you want to save all changes up
to the last command - to be safe, answer
NO to this prompt. You will lose any
changes made after the last save, but you
will not introduce any corrupt data into the
current saved drawing.

Corrupt Drawings:  If you have a corrupt
drawing (one that will not open, or one that
causes Carlson Survey/Roads to crash),
sometimes this is very simple to fix. Open
Carlson Survey/Roads and choose New
from the File menu. Select the "start from
scratch" button on the "Create new Draw-
ing" dialog box. Next, from the Draw menu,
choose Insert. Select the File button and
then choose the drawing that you are hav-
ing problems with. Next, UNselect the "Se-
lect Parameters on screen" toggle, and make
sure the insertion point is set to X=0 Y= 0
and Z=0 and Scale = 1 and Rotation = 0.
Click OK and then choose Extents from the
Display menu.
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It is no accident that Tsunami (pronounced
�Soo-nom-ee�) has arrived at the same time
as the new millennium.  It represents the
future.  Tsunami is the first data collection
product that operates within AutoCAD it-
self.  It is unique and revolutionary.  Tsu-
nami eliminates the need for �field-to-fin-
ish�, �downloading� and �data conversion�,
and even minimizes the amount of office
preparation needed to prepare for stakeout.
Tsunami works on all major brands of GPS
and total station instruments.  Tsunami of-
fers maximum visualization and field
power, all based on the universally standard
AutoCAD platform.

The Surveyor�s Arsenal:  The technology
tools available to the surveyor have prolif-
erated since just 1980.  They include, in ap-
proximate order, electronic total stations,
DOS-based COGO software, DOS-based
data collectors, computer-aided-drafting
(CAD) and CAD-based survey/civil engi-
neering software, on-board data collectors,
computerized �field-to-finish�, post-pro-
cessed GPS, robotic �one-man� total sta-
tions, sub-centimeter �real-time� GPS,
Windows CE data collection and now CAD-
based data collection.  Were you a skeptic
at any time or did you keep up?  We invite
you now to catch the wave with Tsunami.

Technical Advantages with Tsunami: As
field data collection has developed, survey-
ors have demanded more and more graph-
ics.  At a minimum, they have demanded

TTTTTsunami!sunami!sunami!sunami!sunami!
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point plots, then plots of
centerlines, profiles and
templates, and that�s as
far as the market has pro-
gressed to date.  Now
with Tsunami, the entire
drawing appears on the
screen.  In addition to use
of touchpads or
touchscreens, arrow keys
can be used to pan, and
Page Down and Page Up
will zoom in and out.
Function keys or pressing
Enter will take shots.
Text and linework can be
added while in the field.  The field crew can
forget having to recall complex coding for
�field-to-finish�.  It�s not necessary.  Just
turn on linework as you collect and it draws
in the field.  Contours can be drawn in sec-

onds to
check the
quality of
the field-
work.  If the
c o n t o u r s
aren�t ad-
equate, get
more field
shots, add
breaklines,
then re-con-
tour.  Since
points plot
in real-time,
there is no
chance that
areas will be
overlooked

or duplicated during topo work or as-built
surveys.  Stakeout can be conducted by snap-
ping to points on the screen or by station
and offset, requiring little or no office
preparation and pre-calculation of stakeout
points.  With robotic total stations or real-
time GPS, the rodman�s position is seen
with respect to the target point and the lo-
cal graphics (linework, text and points) at
all times. Tsunami eliminates the trips back
to the office to upload more stakeout data.
The key is, your drawing is with you in the
field.  And for that reason, downloading and
file conversions are eliminated.  Just copy
your field files to the office computer!  For
that matter, your field computer may double
as your office computer.

Field Computers�Pros and Cons:  Tsu-
nami is gaining steam as more lightweight

field computers with good outdoor
viewability come online in the marketplace.
The Sony PictureBook (~$2750) is super
lightweight (3.2 lbs), bright, and has the
ability to take pictures of points, which can
store with the GIS data (see below).

The Panasonic Toughbook (~$3500) is 3.9
lbs, brighter than the Sony, ruggedized and
is a touchscreen.  The Fujitsu computer (b/
w or color and $2500 to $6500 depending
on configuration) is a keyboardless
touchscreen.  These computers can be con-
figured with 64mb RAM and up to 4 gb hard
drives.

GIS Applications:  Tsunami has three ways
to gather GIS data:  by entering �random�
notes, by entering �prompted� notes with
default responses, and by entering
�prompted� notes in a table that outputs di-
rectly to an MDB file and links data to the
drawing in classic GIS fashion.  Entering
FH (or just F), for example, could trigger
the fire hydrant prompts assuming the
prompts are saved in a file called FH.mdb.
Entering WV (or just W) would trigger the
water valve prompts based on a WV.mdb
prompting file.  Tsunami offers high-tech,
high-visual GIS compatible with AutoCad
MAP, but also includes output to shapefiles
for import to ESRI.  Tsunami is an excel-
lent �software companion� for the afford-
able sub-meter accuracy GPS systems
available from Leica, Sokkia, Ashtech and
Javad.

Specifications: Tsunami requires Windows
95, 98 or NT.  It works as an add-on menu
within AutoCad 14, AutoCad 2000, LDD,
MAP R2, MAP R3 and MAP2000 and
standalone based on the Carlson Survey en-
gine.  Tsunami costs $1295 or $2500 when
purchased with Carlson Survey.

Mounting brackets are available for $250
for both GPS and total station applications.
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Julia Lipman, B.S. in Mathematics/Computer Science from
M.I.T.  Julia joins our Boston office as a software engineer.  To
date, Julia has been involved in our new TruckPRO product (Euclid
truck download and data management) and is developing an ex-
panded Least Squares analysis for raw traverse closure.

James Brooks, B.S. in Civil Engineering from M.I.T. has also
joined our Boston office as a software engineer.  James has con-
centrated on Dozer 2000 and HydroStar.

Randy McSwain, from an engineering firm in Houston, Texas,
brings a strong CAD background and lisp programming experi-
ence.  Randy is involved in tech support, quality control and sales.
Randy is located in our Maysville, KY office.

Rob Rasnic, a sales engineer, formerly of Seiler Instruments,
will head up our St. Louis sales office.  Rob has a strong back-
ground in Autodesk products and will help in our efforts to de-
velop LDD add-ons.

Boyd Jensen, formerly of Western Water Consultants in Sheridan,
Wyoming, heads up the Carlson Training Program and does direct
sales and on-site support.  Boyd also is based in Maysville.

New EmployeesNew EmployeesNew EmployeesNew EmployeesNew Employees

Carlson Software sells and delivers products directly and through
a dealer network.  We appreciate our dealers, and want to encour-
age our existing and potential customers to contact dealers for
price quotations and product demos.  Dealer inquiries are wel-
come.  Below is a list of dealers who have been active in selling
Carlson products in recent years:
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We would also like to recognize our �award winning� dealers for
1999, based on these products:
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Carlson Survey:  Marel of Puerto Rico and Allen Precision

SurvStar:  Thorpe-Smith, Laser Specialists, Precision Products

Tsunami Sales:  Thorpe-Smith and Allen Precision

SurvCADD Sales:  Anderson Instruments

Carlson Sales InquiriesCarlson Sales InquiriesCarlson Sales InquiriesCarlson Sales InquiriesCarlson Sales Inquiries
National Sales Office ........................ 800-989-5028

St. Louis Sales Office ......................... 877-235-1184

East Coast Sales Office ..................... 800-283-0023

Boston Sales Office ............................ 877-221-6199


